
Šta je QuarkXPress?
QuarkXPress je program za oblikovanje
izgleda stranica nekog dokumenta. Program
kojim se oblikuje stranica je središno mesto
za prikupljanje teksta, slika, linija i tabela, pri
čemu svi zajedno sačinjavaju stranicu ili niz
stranica dokumenata. QuarkXPress se može
koristiti za izradu bilo čega, u rasponu od
etiketa na košuljama ili majicama, do encik-
lopedije u više tomova. Gotov dokument
može da se štampa na kućnom laserskom
štampaču (letak, pozivnica itd.), da se obradi
na uređaju za osvetljavanje kako bi bio odšta-
mpan na profesionalnoj štamparskoj mašini
(knjiga, časopis, brošura itd.), ili da se pri-
premi za objavljivanje preko Interneta.
U ovom poglavlju su samo nagoveštene
osnovne mogućnosti programa
QuarkXPress. Tek u ostalim poglavljima
naučićete kako da stvarno napravite stranice
ili elemente stranica dokumenta.

Elementi za gradnju u programu
QuarkXPress
■ Da biste smestili tekst na stranicu,

morate ga uneti ili uvesti u pravougaoni
ili nepravilno oblikovani okvir za tekst �
ili duž Bezjeove krive putanje teksta �. 
Na sličan način, da biste sliku smestili na
stranicu, prvo morate napraviti prostor
za nju, bilo da je taj prostor jednostavni
pravougaoni ili zamršeni Bezjeov okvir
za sliku. Tek tada možete uneti sliku u
njega. Ako želite da se ivica okvira za
tekst ili za sliku štampa, na njega morate
staviti ram � – � .  
Linija može biti prava ili kriva i koristi se
kao ukrasni element. Tabela se sastoji od
ćelija; u svakoj ćeliji može se nalaziti
tekst ili slika.

■ Okvir za tekst, putanja za tekst, okvir za
sliku, tabela ili linija, nazivaju se objekat.
Slika ili tekst koji se nalaze u nekom
okviru nazivaju se sadržaj. 
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Lepotica i zver
� Tekst na putanji

“Lepotice! Patio sam otkako si me

zaboravila. Sada želim da umrem u

miru...” “Živi!”- zavapi Lepotica.

“Oženi se samnom. Kako bih mogla

da živim bez tebe, moja najdraža

Zveri?”)

� Polje za tekst sa ramom

� Slika u okviru
bez rama

� Slika u okviru za
sliku (sa tankim
ramom od 0,5 pointa)

Osnove 1



Okvir za sliku ili za tekst takođe mogu
da se naprave prazni, posle čega se u
potpunosti ponašaju kao obojeni oblici. 

■ Biranje alatke je prvi korak u većini uput-
stava za rad u ovoj knjizi. Da biste napra-
vili neki objekat, na primer, koristićete
odgovarajuću alatku za izradu objekata,
kao što su alatka za crtanje linija ili alatka
za pravougaoni okvir za tekst .
Da biste čitav objekat ili grupu objekata
premestili s jednog mesta na drugo,
koristićete alatku za biranje objekata
Item � pošto ćete raditi sa celokupnim
sadržajem objekta.
Da biste iskopirali, obrisali ili promenili
izgled teksta ili slike pošto su već uneti
ili uveženi, koristićete alatku za biranje
sadržaja objekata Content, jer ćete
raditi sa sadržajem unutar, a ne izvan
određenog objekta. 
Za neke poslove alatke Item i Content
mogu da menjaju jedna drugu. Na pri-
mer, alatka Content se može koristiti za
menjanje oblika ili veličine objekata ili za
biranje više objekata istovremeno. Alatka
Item se može koristiti za uvoženje slika.

■ Neki objekat ili njegov sadržaj moraju
da budu izabrani pre nego što mogu da
budu menjani � – �.

■ Prikaz na paleti Measurements se menja
u zavisnosti od toga koja alatka i koja
vrsta objekata su izabrani (�, sledeća
stranica). Leva strana ove palete prika-
zuje informacije koje se odnose na od-
ređeni objekat – okvir za sliku, okvir za
tekst, putanju teksta, tabelu ili liniju –
ako se izaberu taj objekat i alatka Item
ili Content. Informacije o objektu obuh-
vataju njegove dimenzije i položaj na
stranici.
Desna strana palete Measurements
prikazuje informacije o sadržaju slike ili
teksta, kao što je njegova veličina, ako se
izaberu taj objekat i alatka Content (�,
sledeća stanica). Desna strana palete
Measurements prikazuje informacije o
vrsti i debljini linije ako se izaberu linija
i alatka Item ili Content. Ova paleta je
prazna ako ni jedan objekat nije izabran
(�, sledeća strana). 
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� Okvir za sliku koji nije izabran.

� Kada se okvir izabere, prikazuje se
osam markera. 

Alatka Content

Alatka Item

Dve najčešće korišćene alatke

� 
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Jednostavna konverzija

� Paleta Measurements kada su izabrani alatka Item i okvir za tekst.

� Paleta Measurements kada su izabrani alatka Content i tekst.

� Kada nijedan objekat nije izabran, paleta Measurements je prazna. Izaberite neki objekat da bi ova paleta
zablistala u punom sjaju.

Informacije o objektu Informacije o sadržaju objekta

Ako nije jedno, onda je nešto drugo
Naš prvi susret sa programom QuarkXPress
bio je 1988. godine ( u svetu softvera, to je
davna istorija), i bili smo zadivljeni njegovom
preciznošću, ali razočarani njegovom neu-
moljivom hijerarhijskom arhitekturom. Novi
objekti su crtani unutar – bili su određeni –
već postojećim objektima. 

Sada je QuarkXPress prilagodljiv u istoj meri
kao što je u početku bio krut. Ne samo da
možete smestiti neki objekat bilo gde, nego
možete bilo koji objekat (okvir za tekst,
putanju teksta, okvir za sliku ili liniju)
pretvoriti u nešto sasvim drugo � – �. Ako
ste potpuni novajlija u programu
QuarkXPress (ili ste nepopravljivo neodlu-
čni), za sada ne obraćajte pažnju na ovo svoj-
stvo programa QuarkXPress. Ali da bismo
zagolicali vašu maštu, navodimo samo neko-
liko preobražaja koje možete izvesti:

■ Promeniti okvir za tekst u okvir za sliku,
liniju u okvir ili putanju teksta, i obrnuto.

■ Napraviti da okvir za tekst ili za sliku budu
prazni – pri čemu je jedino moguće da im
se promeni boja ili veličina (sadržaj bilo
koje vrste okvira se briše tokom pretvara-
nja). 

■ Promeniti standardni okvir u Bezjeov okvir
ili Bezjeovu krivu, ili obrnuto. 

■ Promeniti tekstualni znak u okvir za sliku.

� Pomoću podmenija
Item >Shape, možete
promeniti jedan oblik u
drugi, kao recimo okvir u
liniju ili standardni okvir
u Bezjeov okvir.

� Koristeći podmeni Item >Content,
možete promeniti okvir za tekst u okvir
za sliku, ili obrnuto, ili možete bilo koji
od njih učiniti da budu prazni.



Život kućnih ljubimaca
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Magazin za obožavaoce decembar 2002
kućnih ljubimaca

B O W S E R

SPECIJALNO PRAZNIČNO IZDANJE

Božićni ručak vašeg psa
Pomozite vašem ljubimcu suočenom sa prazničnom
depresijom

Mačiji provod za Novu godinu

Ukrašavanje kućice za psa
Šnaucer štrudla
PLUS

Ukrašavanje kolača
Najbolji pokloni za vaše ljubimce

Providni okvir za tekst
povrh okvira za sliku

Unesite tekst na
Bezjeovu putanju

Bezjeov okvir za
sliku sa ramom

Linija

Elementi za gradnju u programu QuarkXPress: okviri za slike, okviri za tekst, putanje za tekst, linije
(i tabele).



5.0!

Štampanje dokumenata i Web
dokumenata
Mogućnost programa QuarkXPress 5 � –
� da se u njemu izrađuju Web dokumenata
predstavlja najvažniju novu osobinu ovog
programa, a obrađujemo je u poglavljima 19
i 24. Kada počnete da učite kako da napra-
vite dokument za štampanje, počevši od
narednog poglavlja pod naslovom Početak,
imajte na umu da većina, ali ne baš sve,
mogućnosti programa koje se koriste za
izradu dokumenata za štampanje stoji na
raspolaganju pri izradi Web dokumenata. 
SAVET Osobine teksta koje ne postoje za Web
dokumente, nabrojane su na stranici 124.
Možete napraviti Web stranicu u programu
QuarkXPress koristeći prilagodljiv HTML
tekst; rasterizovani tekst; slike; tabele; intera-
ktivne elemente, kao što su delovi slika ili
teksta koji reaguju na pokrete mišem (tzv.
rollover efekat); dugmad i obrasce sa polji-
ma za unos podataka i poljima za potvrdu.
Kada završite Web dokument, možete ga
pregledati onim Web pretraživačem koji je
trenutno instaliran u vašem operativnom sis-
temu. U dokumentu za štampanje možete
praviti okvire, linije, tekst na putanjama i
tabele; u Web dokumentu možete da ura-
dite sve što smo nabrojali, a pored toga i
obrasce i kontrole na obrascima.
Kontekstni meni
U programu QuarkXPress 5, do većine nje-
govih komandi i mogućnosti može se doći
korišćenjem kontekstnog menija, čime šte-
dite svoju snagu i smanjujete pokretanje miša
�. Mogući izbor na kontekstnom meniju u
velikoj meri zavisi od toga da li se pokazivač
miša nalazi iznad radne površine, lenjira,
praznog prostora, okvira za sliku, okvira za
tekst, putanje teksta, linije, tabele ili palete.
U Mac operativnom sistemu (Mac OS)
imate izbor između dva podešavanja za kon-
tekstni meni. Izaberite Edit > Preferences >
Preferences, zatim pritisnite mišem
Application-Interactive na levoj strani ovog
okvira za dijalog. Ako pritisnite mišem
Control Key Activates: Contextual Menu, da
biste otvarali kontekstni meni potreban je
samo Control-pritisak mišem. Ako umesto
toga pritisnite mišem Control Key Activates:
Zoom moraćete da koristite Control-Shift-
pritisak mišem da biste pristupili kontekst-
nom meniju. U Windowsu je to još
jednostavnije: samo pritisnite desni taster
miša (nije potrebno ništa da podešavate).
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Š
tam

panje; kontekstni m
eni� Stranica Web dokumenta napravljena u pro-

gramu QuarkXPress onako kako izgleda u
nekom Web pretraživaču.

� Ovaj kontekstni meni se
pojavljuje ako koristite
Control-pritisak
mišem/pritisak desnim
tasterom miša u okvir za
tekst alatkom Item.

Alatka Rectngle Image Map

Alatka Form Box

Alatka Text Field

Alatka Button

Alatka Image Button

Alatka Pop-up Menu

Alatka List Box

Alatka Radio Button

Alatka zCheck Box

� Paleta alatki Web Tools

5.0!
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9 Granica
stranice
(stvarna)

Međustuba-
čna belina

10 Pomoćna radna
površina

14 Polje za promenu
veličine prozora

12 Polje za veličinu
prikaza 13 Pomoćni meni za prelazak

na određenu stranicu

8 Lenjiri

6 Dugme za
zatvaranje

7 Koordinatni
početak lenjira

11 Vođice margina

Izgled ekrana programa QuarkXPress: Mac OS

1 Paleta
alatki

3 Naslovna
linija

2 Linija menija

5 Dugme za
smanjivanje

Neke od paleta

Vođice lenjira

4 Dugme za zumiranje
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1 Paleta alatki 
Većina paleta se otvara iz menija View:
Tools (i Web Tools), Measurements,
Document Layout, Style Sheets, Colors,
Trap Information, Lists, Layers, Profile
Information, Hyperlinks, Index, Sequences
i Placeholders. Palete Library se izrađuju i
otvaraju preko menija File. Do većine
komandi, koje se nalaze u meniju, može se
mnogo brže doći iz palete Measurements.
Palete koje su otvorene kada napuštate/zat-
varate QuarkXPress biće opet otvorene pri
ponovnom pokretanju programa. 

2 Linija menija
Pritiskom mišem na bilo koji naziv iz
menija pristupa se nizu okvira za dijalog,
padajućih menija, komandi i mogućnosti.
Do pomoćnih programa XTensions se
takođe dolazi preko menija. 

3 Naslovna linija
Naziv dokumenta se prikazuje na njegovoj
naslovnoj liniji. Povlačenjem naslovne linije
pomera se prozor odgovarajućeg dokume-
nta. 

4 Dugme za zumiranje 
Pritisak na dugme za zumiranje povećava
prozor dokumenta tako da se raširi po
čitavom ekranu, a ponovni pritisak na ovo
dugme vraća prethodnu veličinu prozora. 

5 Dugme za smanjivanje 
Pritisak mišem na dugme za smanjivanje
skuplja prozor dokumenta tako da se
smanji samo na svoju naslovnu liniju;
ponovni pritisak mišem na ovo dugme
vraća prethodnu veličinu prozora.

6 Dugme za zatvaranje 
Pritisak mišem na dugme za zatvaranje zat-
vara trenutno aktivnu datoteku.

7 Koordinatni početak lenjira
Prevlačenjem koordinatnog početka lenjira
premešta se presek horizontalnog i vertika-
lnog lenjira, takođe poznat kao nulta tačka.
Ponovnim pritiskom mišem na koordinatni

početak lenjira, nulta tačka se dovodi u
početni položaj u gornji levi ugao stranice.

8 Lenjiri
Za podrazumevane merne jedinice lenjira i
polja za unos mera možete birati između inča,
decimalnih inča, pajkova, pointa, milimetara,
centimetara, cicera i agita. Pored toga, u Web
dokumentima možete da izaberete i piksele.
Iz menija View možete birati između Show
Rulers (prikaži lenjire) ili Hide Rulers (sakrij
lenjire). Pomoćne linije (vođice) koje se
mišem povlače iz vertikalnog i horizontalnog
lenjira se ne štampaju, a koriste se za poravna-
vanje i postavljanje objekta.

9 Granica stranice
Stvarna granica stranice.

10 Pomoćna radna površina
Pomoćna radna površina služi kao mesto
gde se prave skice elemenata stranice ili
kao prostor u kome se privremeno drže ele-
menti stranice da bi se kasnije koristili.
Web dokumenti nemaju pomoćnu radnu
površinu.

11 Vođice margina
Vođice margina, koje se inače ne štampaju,
prikazuju se samo u svrhu lakšeg pakovanja
objekata na stranici. Iz menija View možete
da birate između Show Guides (prikazati
linije) ili Hide Rulers (sakriti linije).

12 Polje za veličinu prikaza
U ovom polju se prikazuje i moguće je
promeniti stepen uvećanja prikaza doku-
menta.

13 Pomoćni meni za prelazak na određenu
stranicu

Iz ovog menija se može izabrati prikazi-
vanje proizvoljne ili matične (master)
strane dokumenta. 

14 Polje za promenu veličine prozora
Povlačenjem mišem polja za promenu
veličine prozora menja se veličina prozora
dokumenta.

Objašnjenje izgleda ekrana programa QuarkXPress
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11 Granica
stranice
(stvarna)

12 Pomoćna radna
površina

16 Polje za promenu
veličine prozora

14 Polje za veličinu prikaza 15 Padajući meni za prelazak
na određenu stranicu

10 Lenjiri

9 Koordinatni
početak
lenjira

6 Dugme za zatvaranje
prozora programa

5 Dugme za povećanje prozora programa

4 Dugme za smanjivanje
prozora programa

13 Vođice margina

Izgled ekrana programa QuarkXPress: Windows

1 Kontrolni meni
programa

3 Linija menija

1 Kontrolni meni
dokumenta

7 Paleta
alatki

2 Naslovna linija programa 

8 Naslovna linija
dokumenta

Neke od paleta

Dugme za zatvaranje
prozora dokumenta

4 Dugme za smanjivanje
prozora dokumenta

Vođice lenjira
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ress (W

indow
s) 

1 Kontrolni meni programa (ili dokumenta)
Komande iz kontrolnog menija programa
su: Restore (vratiti na prvobitnu veličinu),
Move (pomeriti), Size (promeniti veličinu),
Minimize (smanjiti), Maximize (povećati) i
Close (zatvoriti). Pored ovih komandi u
kontrolnom meniju dokumenta nalazi se i
komanda Next (sledeći dokument).

2 Naslovna linija programa
Naslovna linija programa sadrži naziv odgo-
varajućeg programa. Ako je neki dokument
maksimalno uvećan, u naslovnoj liniji pro-
grama se prikazuje naziv tog dokumenta. 

3 Linija menija
Pritiskom mišem na bilo koji naziv iz menija
pristupa se nizu okvira za dijalog, padajućih
menija, komandi i mogućnosti. Do
pomoćnih programa XTensions se takođe
dolazi preko menija. 

4 Dugme za smanjivanje prozora programa
(ili dokumenta)

Pritisak mišem na dugme za smanjivanje
prozora programa umanjuje program na
ikonu na paleti poslova. Pritiskom mišem
na tu ikonu vraća se prethodna veličina pro-
zora programa.
Pritisak mišem na dugme za smanjivanje
prozora dokumenta umanjuje dokument na
ikonu u levom uglu prozora programa.
Pritiskom mišem na tu ikonu vraća se
prethodna veličina prozora dokumenta.

5 Dugme za povećanje/vraćanje na prvobitnu
veličinu prozora programa (ili dokumenta)

Pritisak mišem na dugme za vraćanje na
prvobitnu veličinu prozora programa ili
dokumenta vraća prethodnu veličinu odgo-
varajućeg prozora. Kada neki prozor ima
svoju prvobitnu veličinu, dugme za vraćanje
na prvobitnu veličinu se menja u dugme za
uvećanje prozora. Pritisak mišem na ovo
dugme povećava veličinu prozora. 

6 Dugme za zatvaranje prozora
Pritisak mišem na dugme za zatvaranje zatvara
program, dokument, okvir za dijalog ili paletu. 

7 Paleta alatki 
Većina paleta se otvara iz menija View:
Tools (i Web Tools), Measurements,
Document Layout, Style Sheets, Colors,
Trap Information, Lists, Layers, Profile
Information, Hyperlinks, Index, Sequences
i Placeholders. Palete Library se izrađuju i
otvaraju preko menija File > New > Library. 

8 Naslovna linija dokumenta
Ovde se pojavljuje naziv dokumenta.
Povlačenjem naslovne linije pomera se pro-
zor odgovarajućeg dokumenta unutar pro-
zora programa (ovo nije moguće ako je
prozor dokumenta maksimalno uvećan). 

9 Koordinatni početak lenjira
Povucite koordinatni početak lenjira da biste
premestili presek („nultu tačku”) horizon-
talnog i vertikalnog lenjira. Ponovnim pri-
tiskom na dugme koordinatnog početka
lenjira, nulta tačka se dovodi u početni
položaj u gornji levi ugao stranice.

10 Lenjiri
Za podrazumevane merne jedinice lenjira i
polja za unos mera možete birati između inča,
decimalnih inča, pajkova, pointa, milimetara,
centimetara, cicera i agita. Pored toga u Web
dokumentima možete da izaberete i piksele.
Iz menija View možete da birate između Show
Rulers (prikazati lenjire) ili Hide Rulers (sak-
riti lenjire). Pomoćne linije (vođice) koje se
mišem povlače iz vertikalnog i horizontalnog
lenjira se ne štampaju, a koriste se za poravna-
vanje i postavljanje objekta.

11 Granica stranice
Stvarna veličina stranice.

12 Pomoćna radna površina
Pomoćna radna površina služi kao mesto gde
se prave skice elemenata stranice ili kao pros-
tor u kome se privremeno drže elementi
stranice da bi se kasnije koristili. Web doku-
menti nemaju pomoćnu radnu površinu.

13 Vođice margina
Vođice margina, koje se inače ne štampaju,
prikazuju se samo u svrhu lakšeg pakovanja
objekata na stranici. Iz menija View možete
da birate između Show Guides (prikaži lini-
je) ili Hide Rulers (sakrij linije).

14 Polje za veličinu prikaza
U ovom polju se prikazuje i moguće je pro-
meniti stepen uvećanja prikaza dokumenta.

15 Padajući meni za prelazak na određenu
stranicu

Iz ovog menija se može izabrati prikazivanje
proizvoljne ili matične (master) strane
dokumenta. 

16 Polje za promenu veličine prozora
Mišem povucite polje za promenu veličine
prozora da biste promenili veličinu prozora
dokumenta.

Objašnjenje izgleda ekrana programa QuarkXPress
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Paleta alatki
Paleta alatki obuhvata 30 alatki koje se
koriste za izradu i obradu objekata. 

■ Da biste otvorili paletu alatki, izaberite
View > Show Tools (F8).

■ Vidljiva alatka se bira pritiskom mišem,
skrivene alatke se biraju iz padajućeg
menija.

■ Podrazumevana paleta alatki prikazana
je na slici desno, ali je moguće
promeniti njen izgled. Da biste neku
alatku premestili iz padajućeg menija u
prvi nivo palete, prilikom biranja te
alatke držite pritisnut taster
Control/Ctrl. Control-pritisak
mišem/Ctrl-pritisak mišem na neku
alatku vraća je u njen padajući meni.
Kada ponovo pokrenete program,
važiće onakav raspored alatki na paleti
alatki kakav je poslednji korišćen pre
zatvaranja programa. 

■ Da bi bilo koja od alatki za izradu ili
povezivanje objekata ostala izabrana,
držite pritisnut taster Option/Alt pri
izboru te alatke. Da biste poništili izbor
neke alatke, pritisnite mišem drugu
alatku.

■ Da biste promenili podešavanja neke
od alatki, dva puta brzo pritisnite levim
tasterom miša na tu alatku (pogledajte
stranicu 391), a zatim pritisnite mišem
Modify. 

■ Da biste dobili alatku Item kada je
izabrana alatka Content, držite pritisnut
taster Cmd/Ctrl.

■ Da biste vratili podrazumevani izgled
palete alatki, izaberite Edit >
Preferences > Preferences > Document-
Tools, pritisnite mišem Default Tool
Palete, a zatim pritisnite mišem OK.

■ Ako je polje za potvrdu Show Tools
Tips u Edit > Preferences > Preferences
> Application-Interactive overeno,
možete postaviti pokazivač miša na
vidljivoj alatki ili dugmetu palete i na
ekranu će se pojaviti njihov naziv.

Alatka Item
Bira, menja veličinu, kopira i
menja oblik objekata i putanja.

Alatka Content
Unosi tekst; uvozi, obrađuje i
menja izgled teksta i slika; vrši
neke od poslova alatke Item.

Alatka Rotate
Ručno rotira objekte.

Alatka Rectangle text box
Izrađuje pravougaone okvire za
tekst.

Alatka Rectangle picture box
Izrađuje pravougaone okvire za
slike.

Alatka Table
Izrađuje tabele .

Alatka Zoom
Menja uvećanje dokumenta.

Alatka Bézier line
Izrađuje otvorene putanje pri-
tiskom ili povlačenjem miša.

Alatka Line text path
Izrađuje pravu putanju teksta pod
bilo kojim uglom.

Alatka Linking
Povezuje tekst iz okvira u okvir.

Alatka Unlinking
Raskida vezu između okvira za
tekst.

Alatka Scissors
Preseca linije, putanje i okvire.

5.0!

5.0!



Alatke na podrazumevanim padajućim menijima
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P
aleta alatki

Linija nacrtana
slobodnom
rukom
Izrađuje krive linije
povlačenjem miša.

Linija
Izrađuje
prave linije
pod bilo
kojim uglom.

Ortogonalna
linija
Izrađuje prave
uspravne ili
položene linije.

Okvir sa
zaobljenim
uglovima

Okvir sa
udubljenim
uglovima

Okvir sa
zakošenim
uglovima

Ovalni
okvir

Bezjeov
okvir za sliku
Bezjeov okvir
koji se sastoji od
temenih tačaka
i odsečaka
linije.

Okvir nacrtan
slobodnom
rukom
Izrađuje Bezjeov
okvir za sliku
povlačenjem
miša.Alatke za crtanje linija

Alatke okvira za sliku

Bezjeova
putanja teksta
Izrađuje putanje
teksta pritiskom i
povlačenjem
miša.

Ortogonalna
putanja teksta
Izrađuje prave
položene ili
uspravne
putanje teksta.

Putanja teksta
nacrtana slobod-
nom rukom
Izrađuje putanje
teksta povlačenjem
miša.

Alatke za crtanje putanja teksta

Okvir
zaobljenim
uglovima

Okvir sa
udubljenim
uglovima

Okvir sa
zakošenim
uglovima

Ovalni
okvir

Bezjeov
okvir
Izrađuje
Bezjeov okvir
za tekst pri-
tiskom ili
povlačenjem
miša.

Okvir nacrtan
slobodnom
rukom
Izrađuje Bezjeov
okvir za tekst
povlačenjem
miša. 

Alatke okvira za tekst



Meniji programa QuarkXPress
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Meni Style
Komande menija Style se koriste za obradu sadržaja
nekog objekta. Kada se izabere tekst, ovaj meni
prikazuje komande za tipografiju i formatiranje para-
grafa. Kada se izabere slika, ovaj meni prikazuje
komande za boju, kontrast, menjanje položaja i
veličine slike. A kada se izaberu linija ili tabela, ovaj
meni prikazuje komande za vrstu linije, njenu
debljinu i boju. Podmeniji Hyperlink i Anchor se
takođe nalaze u ovom meniju.

Meni File
Većina komandi
iz menija File se
primenjuje na
dokument kao ce-
linu, od izrade i
otvaranja datote-
ke do uvoženja i
izvoženja slika i
teksta, a isto tako i
zatvaranje, snima-
nje i pripremu za
štampu.  

Meni Edit
Ovo je možda najviše
upotrebljavani meni
koji se koristi za
poništavanje izmena,
biranje i kopiranje
objekata, menjanje
teksta i osobina tek-
sta i željeno podeša-
vanje osobina
programa. Pomoću
ovog menija
određuju se stilovi,
boje, pravila za
prelamanje reči i
pakovanje teksta,
liste i linije za pred-
vajanje objekata. Na
dnu ovog menija
nalaze se komande
za Web dokumente i
besplatni pomoćni
programi XTensions.

Izabran je tekst.

Izabrana je slika.

Izabrana je linija.

Napomena: U Windowsu pos-
toji komanda Paste Special;
Delete menja Clear, a nema
komande Subscribe.

Napomena: Pomoćne programe XTensions
Jabberwocky, Guide Manager, Shape of Things,
Super Step and Repeat i Type Tricks moguće je
besplatno preuzeti sa Quarkove Web stranice
(stranica 26).

5.0!
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Meni Utilities
Komande iz menija Utilities obuhvataju čitav
niz funkcija, kao što su provera pravopisa,
pravila za rastavljanje reči na slogove, pos-
tupke upotrebe slika i fontova, tabela za
međuslovnu belinu (engl. tracking) i rastoja-
nje između dva slova (engl. kerning) i izradu
indeksa dokumenata.

Meni Help
Ovaj meni omogućava
da se dobije pomoć za
rad sa programom
ugrađena u sam pro-
gram ili neposredno
od kompanije Quark.
Napomena: Uputstvo za
korišćenje (User Guide)
programa je u obliku PDF
datoteke u QuarkXPress
direktorijumu Quark 5
>Documents >Guides (ne u
meniju Help).

Meni Script nije obrađen u ovoj
knjizi.

Meni View
Komande iz menija
View kontrolišu ono
što vidite na ekranu
– stepen uvećanja
dokumenta i prika-
zivanje pomoćnih
linija (vođica),
lenjira, tzv. nevid-
ljivih znakova i
paleta.

Meni Item
Komande iz menija
Item – Modify,
Frame, Group,
Duplicate, Delete,
Lock, Space/Align
itd. – menjaju
celokupne objekte, a
ne ono što se nalazi u
njima. Do ovih
komandi je moguće
doći samo ako je
izabran neki objekat.
Nove mogućnosti
verzije 5.0 pojavljuju
se na donjem delu
ovog menija. 

Meni Page
Komande iz ovog
menija dodaju, brišu,
menjaju redni broj
stranice i prikazuju i
menjaju pomoćne
linije margina i
kolona na stranici.

M
eniji



Strelice nagore i nadole
otvaraju padajući meni.

Da biste pomerili okvir za dijalog,
povucite njegovu naslovnu liniju.
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Okviri za dijalog
Okviri za dijalog liče na obrasce za popunja-
vanje u kojima postoji više različitih izbora.
Na slikama na ovoj i sledećoj stranici
prikazani su različiti načini na koje je mogu-
će vršiti izbor. U polja se mogu uneti brojevi
sa bilo kojim mernim jedinicama koje se
koriste u programu QuarkXPress. Pritisnite
mišem OK ili pritisnite Return/Enter da
biste zatvorili okvir za dijalog i primenili
naznačene izmene.

Okvir za dijalog može se otvoriti preko
menija ili pomoću odgovarajuće prečice sa
tastature. Okvir za dijalog će biti otvoren
kada se izabere neka od stavki na meniju
pored koje se nalaze tri tačkice (...). 

SAVET U svim okvirima za dijalog pritiskom
na tabulator (Tab) prelazi se na sledeće
polje, a pritiskanjem Shift-Tab na
prethodno polje. 
SAVET U nekim okvirima za dijalog možete
iskoristiti prečicu sa tastature Cmd-Z/Ctrl-Z,
dok je okvir za dijalog otvoren da biste
vratili poslednje korišćene vrednosti.

Pritisnite mišem OK ili pritisnite
Return/Enter na tastaturi da biste
zatvorili okvir za dijalog i primenili
nova podešavanja. Možete pritisnuti
Return/Enter za bilo koje dugme koje
ima dvostruku ivicu, kao recimo za
dugme Save.

Pritisnite mišem Cancel (ili
pritisnite Esc) da biste zatvorili
okvir za dijalog tako da unete
izmene nemaju uticaja.

Okvir za dijalog New Document

U Windowsu, ako pritisnete Alt + slovo na tastaturi koje
odgovara podvučenom slovu u okviru za dijalog, biće
istaknuto odgovarajuće polje. Na primer, u okviru za
dijalog prikazanom iznad, pritiskanje Alt + W učiniće
da polje Width postane istaknuto.



Kartice okvira za dijalog
Međusobno povezane stavke su skupljene
zajedno u okviru iste kartice okvira za dija-
log. Na primer, ako izaberete Item >
Modify, pri vrhu odgovarjućeg okvira za
dijalog videćete poređane kartice. Ako je
okvir za dijalog Modify otvoren za menja-
nje neke slike, videćete Box, Picture,
Frame, Runaround, Clipping i OPI kar-
tice. Ovo podseća na kupovinu u robnim
kućama gde se sve plaća pri izlasku.
Recimo da je izabran okvir za tekst i da
izaberete Item > Modify. Mogli biste da
promenite vertikalno poravnanje za ovaj
okvir na kartici Text, pritisnite mišem na
karticu Frame (ram); izaberete kako želite
da izgleda ram teksta, pritisnite mišem
karticu Box (okvir) da biste dodali boju
pozadine – sve to sa jednog mesta.

Pritisnite mišem Apply (ili pritisnite Cmd-A u
Mac OS) da biste pogledali izmene u doku-
mentu dok je okvir za dijalog još otvoren.
Option-pritisak mišem/Alt-pritisak mišem na
Apply (ili pritisak na Alt-A u Windowsu)
dovodi do toga da se unete izmene odmah vide
u dokumentu. Pritisnite Tab da biste sproveli
izmene dok je okvir za dijalog još uvek
otvoren. 

Pritisnite mišem da
biste izabrali iz pada-
jućeg menija.

Sve je prazno
Ako trenutno izabrani tekst ili objekat imaju
različite vrednosti, odgovarajuće polje će biti
prazno. Na primer, ako istaknuti tekst istovre-
meno sadrži prored od 8 pt. i 12 pt. polje
Leading (prored) biće prazno (baš kao što je
prazno polje Leading na slici ispod).
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K
artice okvira za dijalog

Polje za izbor može biti
uključeno ili isključeno.
U istoj grupi istovremeno je
moguće izabrati samo jedno
od ovih polja.

Polje za potvrdu može
biti overeno ili ne.

Pritisnite mišem na
karticu da biste je
prikazali.
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Širina
okvira

Visina
okvira

Horizontalni položaj
gornjeg levog ugla okvira
u odnosu na koordinatni

početak lenjira

Vertikalni položaj gornjeg
levog ugla okvira u

odnosu na koordinatni
početak lenjira

Ugao
rotacije
okvira

Broj kolona
u okviru

Prored

Međuslovna
belina i rastojanje
između slova

Font

Stil slova

Veličina
slova

Horizontalno
ravnanje

Paleta Measurements kada su izabrani alatka Content i okvir za tekst

Paleta Measurements kada su izabrani alatka Content i okvir za sliku

Širina
okvira

Visina
okvira

Horizontalni položaj
gornjeg levog ugla okvira
u odnosu na koordinatni

početak lenjira

Vertikalni položaj gornjeg
levog temena okvira u
odnosu na koordinatni

početak lenjira

Ugao
rotiranja
okvira

Horizontalna
razmera slike

Vertikalna
razmera slike

Preslikavanje
po vertikal-

noj osi

Preslikavanje
po horizon-
talnoj osi

Horizontalni
položaj slike u

odnosu na okvir

Vertikalni položaj
slike u odnosu na

okvir

Ugao
zakošenja

slike

Ugao rotiranja
slike

Palete u programu QuarkXPress

Paleta Measurements
Na paleti Measurements nalaze se neke od komandi i opcija koje već postoje
u menijima. Opcije koje se pojavljuju na paleti Measurements se menjanju u
zavisnosti od toga koja je vrsta objekta ili alatke izabrana u dokumentu. Ova
paleta je prazna kada ništa nije izabrano.

Preslikavanje
po horizontal-

noj osi

Preslikava-
nje po verti-
kalnoj osi

Prečice sa tastature za paletu Measurements
Prikaži/sakrij paletu F9

Istakni prvo polje Cmd-Option-M/Ctrl-Alt-M

Istakni polje za izbor fonta Cmd-Option-Shift-M/Ctrl-Alt-Shift-M

Istakni sledeće polje Tab

Istakni prethodno polje Shift-Tab

Zatvori paletu bez Cmd. (tačka) 
izmena ili Esc

Radijus
zaobljenja 
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Ugao
rotiranja

Dužina
linije

Horizontalni položaj leve
krajnje tačke linije (u

zavisnosti od oblika linije)

Vertikalni položaj leve
krajnje tačke linije (u

zavisnosti od oblika linije)

Oblik linije

Ikona koja
predstavlja
oblik linije

Debljina linije Vrsta linije Završetak linije

Paleta Measurements kada su izabrani alatka Content i prava linija

Širina
Bezjeovog

okvira

Visina
Bezjeovog

okvira

Horizontalni položaj
Bezjeovog okvira u
odnosu na koordi-

natni početak lenjira

Vertikalni položaj
Bezjeovog okvira u
odnosu na koordi-

natni početak lenjira

Ugao rotiranja
Bezjeovog okvira

Ugaona
tačka

Lučni
odsečak

(Dugmad za promenu odsečaka
na Bezjeovom okviru)

(Dugmad za promenu tačke na
Bezjeovom okviru)

Ugao rom-
boidnog

markera krive
u odnosu na

aktivnu
tačku

Ugao
kvadratnog

markera krive
u odnosu na

aktivnu
tačku

Horizontalni
položaj

trenutno
aktivne tačke

Rastojanje romboidnog
markera krive od

aktivne tačke

Vertikalni položaj
trenutno aktivne

tačke

Rastojanje
kvadratnog mar-

kera krive od
aktivne tačke

Paleta Measurements kada su izabrani alatka
Content i jedna od tačaka na Bezjeovoj putanji.

Simetrična
tačka

Glatka
tačka

Prav
odsečak

Poravnanje sa gornjom linijom teksta

Poravnanje sa osnovnom linijom teksta

Leva strana palete Measurements kada su
izabrani alatka Content i vezani okvir.

Horizontalni položaj pomoćne linije (vođice)

Vertikalni položaj pomoćne linije (vođice)

Leva strana palete Measurements prilikom povlačenja
vođica iz horizontalnog lenjira
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Paleta Document Layout
Paleta Document Layout se koristi za prepakovanje, ubacivanje i
brisanje stranica dokumenta; kretanje kroz dokument i za
izradu, menjanje i primenu matičnih stranica.

Paleta Colors
Paleta Colors se koristi za primenjivanje
procesnih, posebnih i boja pogodnih za
upotrebu na Webu na tekst, slike, okvire,
linije i tabele.

Broj trenutno prikazane stra-
nice koja se pokazuje u obliku

praznog/podebljanog znaka
ispod ikone stranice dokume-

nta.

Slovo u sredini ikone
stranice dokumenta
označava koja se
matična stranica, ako
se koristi, primenjuje na
tu stranicu dokumenta.

Ikona naspramne matične strane

Ikone prazne pojedinačne strane i
naspramnih strana

Strelice, traka i okvir
za pomeranje nagore i
nadole

Prikažite neku stranicu
dvostrukim pritiskom

miša na njenu ikonu ili
izaberite njen broj.

Okvir Tekst Pozadina Postotak boje

Spot
boja

Opcije za
mešanje
boja

Procesna
boja 

Stilovi 
pasusa

Stilovi
znakova

Paleta Style Sheets
Paleta Style Sheets se koristi za
primenjivanje stilova koji pred-
stavljaju tačan i detaljan opis
znakova i pasusa u dokumentu.

5.0!



Paleta Lists
Paleta Lists se koristi za pravljenje tabele sa
sadržajem ili abecedni spisak naslova tekućeg
dokumenta ili za knjigu sastavljenu od više
poglavlja.

Izaberite Show List
For za postojeći doku-

ment ili za knjigu.

Naziv spiska

Ažurira spisak u paleti
prozora sa pomerivim
sadržajem.

Pravi spisak u izabranom
okviru za tekst.Pronalazi reč u

spisku iz prozora sa
klizačem.

Uvid u spisak u
prozoru sa
pomerivim
sadržajem.

Paleta Trap Information
Paleta Trap Information se koristi za
određivanje načina za tzv. pasovanje poje-
dinačnih objekata.

Padajući meniji za
biranje vrste paso-
vanja za svaki ele-

ment trenutno
izabranog objekta.

Padajući meni Picture se
pojavljuje ako trenutno izabrani
objekat sadrži uveženu sliku

Izaberite polje „i”(informacije)
da biste saznali zašto je
QuarkXPress izabrao tekuća
podešavanja.
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Paleta Profile Information
Paleta Profile Information se koristi za
prikazivanje trenutnih osobina izabrane
slike i za menjanje njenog profila boje ili
načina nanošenja boje.

Profil boje

Opcija za upravljanje bojom slike

Raspored boja (model boja,
kao što su RGB ili CMYK)

Vrsta slike (color – u boji, grayscale – nijanse sive ili line art – crtež)

Tip datoteke (format datoteke,
kao što su TIFF ili EPS)

Paleta Layers
Paleta Layers vam omogućava da organizu-
jete objekte u dokumentu pakujući ih
prema određenom redosledu. Koristeći
ovu paletu možete da pravite nove slojeve,
premeštate objekte sa jednog sloja na
drugi, povezujete dva ili više slojeva
zajedno, prepakujete slojeve, brišete slo-
jeve, zaključavate slojeve, a možete učiniti i
da slojevi privremeno postanu nevidljivi ili
da se ne štampaju.

5.0!
Novi
sloj

Premeštanje
nekog objekta
na sloj

Brisanje
sloja

Povezivanje
slojeva

Kada se u dokumentu
izabere neki objekat, ova
oznaka pokazuje na kom
je sloju taj objekat.

Pritisnite mišem u kolonu sa okom da
biste prikazali/sakrili određeni sloj.

Pritisnite mišem u drugu kolonu
da biste zaključali/otključali

određeni sloj.

Ikona Edit koja pokazuje
koji je sloj aktivan.
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Paleta Index
Indeks se izgrađuje označavanjem svakog
pojedinačnog unosa koji se indeksira u
stvarnom dokumentu, a zatim korišćenjem
palete Index za određivanje načina formati-
ranja (kao što su izgled ili nivo uvlačenja)
za svaki unos koji se pojavljuje u indeksu.

Tekst koji je trenutno izabran u dokumentu

Polje Sort As služi za menjanje
abecednog položaja nekog

unosa u indeksu.

Nivo (uvlačenja) za određeni unos

Stil koji se primenjuje na broj
stranice na koju se poziva indeks 

(ili tekst „videti”).

Oblast u dokumentu unutar koje
će biti pretraživano za druga
pojavljivanja istog indeksa.

Strelica označava odrednicu indeksa
na koju se odnosi pododrednica

(drugi, treći ili četvrti nivo uvlače-
nja).

Pozivanje na određenu stranicu

Brisanje
unosa

Obrađivanje
unosa

Odrednica drugog nivoa

5.0! Ova dugmad su, sleva nadesno, dodaj (Add), dodaj sve
(Add All) i pronađi sledeći unos (Find Next Entry).



Paleta Placeholders
U programu QuarkXPress se za obliko-
vanje sadržaja XML elemenata koristi
tzv. rezervisana mesta (engl. placeholders).
Za početak, napravi se QuarkXPress
šablon, i u tom šablonu se naprave
prazni okviri za tekst. Zatim se određena
XML datoteka otvori pomoću palete
Placeholders; na ovoj paleti se pojavljuje
hijerarhijski prikaz XML elemenata.
Nazivi elemenata se potom prevlače iz
palete Placeholders unutar pojedinačnih
okvira za tekst u QuarkXPress datoteci, a
svaki naziv rezervisanog mesta u šablonu
se oblikuje na odgovarajući način.

Posle toga, otvara se XML datoteka sa
odgovarajućim elementima korišćenjem
palete Placeholders. Svaki od postojećih
XML elemenata uparuje se sa rezervisa-
nim mestom istog naziva i zadobija
atribute stila iz tog rezervisanog mesta.
Da biste pregledali XML sadržaj koji će
zameniti rezervisana mesta, pritisnite
mišem dugme Toggle Placeholders/
Content. Konačno, da biste na odgova-
rajući način oblikovali XML datoteku,
pritisnite dugme Convert placeholders
to Text. Ako želite više informacija o
rezervisanim mestima, pregledajte
dokumentaciju programa QuarkXPress. 
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Paleta Hyperlinks
Hiperveze („veze”, kraće) su grafička sred-
stva koje Web dizajneri koriste da bi pomo-
gli korisnicima kojima ih vode do ostalih
Web stranica. Postoje različiti oblici veza,
od jednostavnih u obliku podvučenih reči,
do delova slike ili dokumenta koji reaguju
na pokrete miša. U programu
QuarkXPress paleta Hyperlinks se koristi
za pridruživanje veze na istaknuti tekst,
označenu oblast na slici, okvir za sliku ili
drugi izabrani objekat. Veze su interaktivne
samo kada se pregledaju u nekom Web
pretraživaču. Hiperveze mogu da se
pridruže na tekst u dokumentu koji nije
namenjen za objavljivanje na Internetu 
i koji se izvozi u obliku PDF datoteke.  

Povezano odredište

Odredišna
Web stranica

Hiperveza na
Web stranicu

Hiperveza za 
povezivanje

5.0!

5.0!

Biranje XML ili XMT
datoteke koja sadrži DTD

Prikazi-
vanje

/skrivanje
oznaka

Biranje
XML
datoteke

Biranje
XML
direkto-
rijuma

Prethod-
na XML
datoteka

Dugmad na paleti Placeholders

Sledeća
XML
datoteka

Dugme Toggle
Placeholders/Content

Konverto-
vanje
rezervisa-
nog mesta u
tekst

Obrada
Prikazivanje/
sakrivanjeNovo povezivanje

Nova
hiperveza

Brisanje
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Paleta XML Workspace
XML je sistem koji omogućava da se
sadržaj teksta ili slike razvrsta po
redosledu koji pruža veću prilagodljivost
kada se priprema za štampanje ili
objavljivanje na Internetu. Prvo se
svakom osnovnom elementu unutar
XML (tj. polju sa tekstom ili podacima)
dodeljuje poseban naziv i daje mu se
hijerarhijski odnos sa ostalim elemen-
tima u toj XML datoteci. Zatim se sadržaj
(objekti ili paragrafi) QuarkXPress
datoteke povezuje sa različitim elemen-
tima XML datoteke. To se izvodi
povlačenjem okvira sa objektima na ele-
mente u delu XML Tree na paleti XML
Workspace. Ova paleta se takođe koristi
za određivanje i pregledanje XML ele-
menata i njihovog sadržaja, a takođe i za
pregledanje aktuelnog koda u XML
datoteci.

Snimanje Snimanje
pod drugim
nazivom

Vraćanje
na snim-
ljeno
stanje

Pregledanje
XML
datoteke

Usklađivanje
sadržaja

Postav-
ljanje

Dugmad na paleti XML Workspace5.0!

Objekti u dokumentu

Paleta Sequences
Paleta Sequences se koristi za izradu spiska
objekata u QuarkXPress dokumentu, poz-
natom pod nazivom poredak objekata. Ako
se neki poredak objekata prevuče iz palete
Sequences preko elementa na vrhu u paleti
XML Workspace, sadržaj ovih objekata se
automatski povezuje na odgovarajuće XML
elemente.

5.0!

Spisak poredaka objekata

Novi poredak

Dodavanje
objekata

Menjanje
naziva

Premeštanje
objekta naviše

Premeštanje
objekta naniže

Brisanje
Usklađivanje
sadržaja

Pronalaženje
objekta

XML Tree je spisak ele-
menata koji se koriste u

tekućoj XML datoteci



P
al

et
e 

F
in

d/
C

ha
ng

e,
 B

oo
k

24

Poglavlje 1

Dodavanje poglavlja

Matična datoteka
iz koje proističu svi

stilovi, boje itd. 

Kolona Status označava za određeno poglavlje da li je na raspolaganju
(Available), da li se menja (Modified) ili nije dostupno (Missing) i
takođe govori članovima grupe na mreži da li je određeno poglavlje
otvoreno (Open) na tekućem računaru ili na nekom drugom računaru
na mreži.

Premeštanje poglavlja naviše

Premeštanje poglavlja naniže

Odbacivanje poglavlja
Štampanje
poglavlja

Dugme Synhronize book za usklađivanje
stilova, boja, podešavanja za hifenaciju i
poravnanje, liste i ukrasni elementi između
matične datoteke i datoteke poglavlja

Paleta za knjige
Knjiga je skup pojedinačnih poglavlja u
kojoj se međusobno usklađuju njihovi
stilovi, boje, podešavanja za hifenaciju i
poravnanje, liste i ukrasni elementi. Svaka
knjiga ima vlastitu paletu knjige koja se
koristi za dodavanje, brisanje, štampanje i
promenu redosleda poglavlja.

Paleta Find/Change
Paleta Find/Change se koristi za
pretraživanje i menjanje znakova u tekstu,
stilova paragrafa ili znakova, fontova,
veličine slova, vrste slova ili boja.

Tekst, stil i atributi koji se pretražuju unose se ili
biraju u oblasti Find What.

Tekst, stil i atributi kojima se vrši zamena unose se
ili biraju u oblasti Find What.

Ovako izgleda paleta Find/Change kada polje Ignore Attribute nije overeno. 



Ispravite sopstvene greške
Ako ste uznemireni zbog toga što pravite
greške pri radu, opustite se. Nikada (pa
dobro, retko) ćete morati da sve radite
ispočetka ako budete koristili prednosti
svih bezbednosnih mehanizama koje nudi
QuarkXPress. Vaš računar ima memoriju i
vi se možete osloniti na nju. 

U većini slučajeva, poslednja akcija koju ste
izveli može se poništiti korišćenjem Edit >
Undo (Cmd-Z/Ctrl-Z). Nažalost,
QuarkXPress ne nudi mogućnost višestru-
kih poništavanja, tako da ovu komandu
morate odmah da upotrebite. Ako se pre-
domislite, izaberite Edit > Redo (Cmd-Z/
Ctrl-Z – ista prečica sa tastature).

Potrudite se da steknete naviku snimanja
posle manjeg broja obavljenih radnji
(pročitajte stranice 32-34). Iz nekih
razloga, početnici u Quarku nerado koriste
ovu komandu (ili su prezauzeti drugim
poslovima) i sve se završava tako što se
neke stvari nauče na teži način. S obzirom
na to da smo i sami imali nekoliko neprijat-
nih iskustava, sada stalno snimamo, a
imamo i običaj da snimimo dokument pre
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Paleta biblioteke objekata
Palete biblioteke objekata se koriste za
čuvanje bilo kog objekta ili grupe objekata:
okvira za slike (sa ili bez slika), okvira za
tekst (sa ili bez teksta), linija, putanja tek-
sta ili tabela. Da biste dodali neki objekat u
određenu biblioteku, jednostavno ga pre-
vucite u odgovarajuću paletu. Da biste isko-
ristili neki objekat (ili grupu objekata) iz
biblioteke, prevucite ga iz biblioteke u pro-
zor svog dokumenta. Možete napraviti
neograničeni broj paleta sa bibliotekama
objekata, a moguće je istovremeno otvoriti
više njih.

Objekti u biblioteci se
pojavljuju kao uma-

njeni prikaz na paleti
biblioteke objekata.

Pošto se određenim
objektima u biblioteci
dodeli neka oznaka,

moguće ih je selek-
tivno prikazati na

osnovu oznaka
pomoću ovog pada-

jućeg menija.

nego što počnemo sa izvođenjem bilo kog
iole složenijeg posla. U tom slučaju, ako
napravimo nepopravljive brljotine, izabere-
mo File > Revert to Saved da bismo dobili
poslednju snimljenu verziju tog dokume-
nta. 

Prečica sa tastature za poništavanje (Cmd-Z
/Ctrl-Z) se takođe može koristiti za obna-
vljanje poslednje korišćenih podešavanja u
otvorenom okviru za dijalog. Da biste otka-
zali okvir za dijalog istovremeno ne prime-
nivši bilo kakve vrednosti, pritisnite mišem
Cancel (Cmd-./Ctrl-.).

QuarkXPress ima dve mogućnosti za
čuvanje celokupnog dokumenta:
automatsko snimanje i automatsko pravlje-
nje rezervnih kopija. O ovim mogućnosti-
ma čitajte na stranici 383.

I, na kraju, ako radite na nekom složenom
objektu, možete napraviti njegov duplikat
(Item > Duplicate ili Cmd-D/Ctrl-D) i saču-
vati ovu kopiju za svaki slučaj (smestite je
na pomoćnu radnu površinu). Ako se desi
nešto nepredviđeno, možete kasnije česti-
tati sami sebi na dalekovidosti. 



Proširivanje programa QuarkXPress
pomoćnim programima XTensions
Šta je to XTensions?
QuarkXPress ne može baš sve. U stvari,
jedan od razloga njegovog uspeha na tržištu
je to što su nezavisni pisci programa napisali
na stotine dodatnih softverskih modula za
njega, koji se nazivaju XTensions i koji pro-
širuju ili poboljšavaju njegove mogućnosti.
XTensions programi rade skoro sve – od
jednostavnog poravnavanja objekata do
pravljenja baze podataka objekata, a cene
im se kreću u opsegu od zanemarljivih suma
do nekoliko stotina dolara.
XTensions programi se povremeno pominju
u ovoj knjizi, ali s obzirom na to da ih ima
na stotine, to je očigledno samo njihov
manji deo (pored toga, neki XTensions pro-
grami možda neće postojati ili će biti izme-
njeni pošto ova knjiga bude objavljena*).
Proverite da li je XTensions program koji
koristite optimizovan za QuarkXPress verzija
5. Da biste dobili informacije o XTensions
programima koji su već instalirani, izaberite
Utilities > XTensions Manager, pritisnite
mišem na naziv određenog XTensions pro-
grama, a zatim pritisnite mišem About.

Zašto bi mi bilo potrebno da instaliram
XTensions programe?
Da biste koristili XTensions program, on
mora da bude instaliran u direktorijum
XTension u okviru direktorijuma gde je
instaliran QuarkXPress. Neki XTensions
programi dolaze sa pomoćnim programom
za instalaciju koji će obaviti sav posao
umesto vas; drugi moraju da se ručno
iskopiraju u direktorijum XTension. Ako
pomoćni program za instalaciju smesti neki
XTensions program u QuarkXPress direk-
torijum, ali ne i u XTension direktorijum,
obavezno ga sami prebacite u ovaj direktori-
jum.
Pošto se neki XTensions program pravilno
instalira na vaš čvrsti disk, možete koristiti
komandu XTensions Manager u okviru
samog programa da biste ga uključili ili
isključili (pročitajte stranice 393-395). Da
biste mogli da koristite novouključene
XTensions programe, moraćete da zatvorite
i ponovo pokrenete QuarkXPress.
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Kupovina XTensions programa
Neki XTensions programi se prodaju pojedi-
načno, dok se drugi prodaju zajedno, kao recimo
XPert Tools i Xdream. Srećom, većina XTensions
programa postoji u demo verziji, tako da možete
da ih isprobate pre nego što uložite novac.

Za katalog XTensions programa posetite Quark
Web prezentaciju: www.quark.com. Za svaki
XTensions program nabrojani su nazivi i brojevi
telefona njihovih proizvođača. Da biste videli
spisak prodavaca, koji obuhvata i prodavce širom
sveta, pritisnite mišem XTensions Catalog (na
desnoj strani ekrana, bar je tako dok ovo
pišemo), zatim pritisnite mišem Resource
Locator: Where to Buy. Takođe možete da
besplatno preuzmete XTensions programe sa
ove prezentacije, recimo Shape of Thing kojim
se izrađuju okviri u obliku zvezda, tako da vredi
posetiti ovu prezentaciju samo zbog toga. Ostali
besplatni XTensions programi koje je moguće
preuzeti su Jabberwocky, Guide Manager, Super
Step and Repeat i Type Trick. 

Ao biste radije da XTensions programe kupite od
nekog prodavca koji ih ima od raznih
proizvođača, probajte www.thepowerxcha-
nge.com (pritisnite mišem QuarkXPress pri
vrhu njihove uvodne stranice). 

Raspitajte se i kod prodavca i kod proizvođača od
koga naručujete XTensions program za način kako
možete da dobijete buduća unapređenja tog pro-
grama i da li imaju tehničku podršku korisnicima.

I dok ste još tu, posetite našu Web prezentaciju za
savete i korisne informacije:
www.xpressobar.com (ne odnosi se na kom-
paniju Quark, Inc.).

* U vreme kada ovo pišemo, XTensions programi
kompatibilni sa verzijom 5.0 nisu još postojali, tako
da neke od naših informacija o određenim XTensions
programima mogu biti netačne ili zastarele. Svrha
zbog koje pominjemo pojedine XTensions programe je
da vam damo osećaj šta je sve moguće dobiti, ne da
ih hvalimo. 

U okviru komande Edit > Preferences >
Preferences > Application-XTensions
Manager možete da odredite da li
XTensions Manager hoće ili neće da se
otvara pri svakom pokretanju programa
QuarkXPress (pročitajte stranicu 384). 
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Merne jedinice
Osim nekoliko izuzetaka, vrednosti u pale-
tama i okvirima za dijalog prikazuju se sa
tekućom podrazumevanom mernom
jedinicom. Da biste izabrali novu podra-
zumevanu mernu jedinicu za sve buduće
dokumente, zatvorite sve otvorene doku-
mente; da biste promenili merne jedinice
samo za određeni dokument, ostavite taj
dokument otvoren. Idite na Edit > Prefe-
rences > Preferences, pritisnite mišem
Measurements u okviru Document or Web
Document, a zatim u okviru Horizontal
i/ili Vertical izaberite Inches, Inches Deci-
mal, Picas, Points, Milimetars, Centimetars
ili Agates � – �. Za Web dokumente
možete takođe izabrati Pixels. Web i doku-
ment za štampanje mogu imati različite
podrazumevane merne jedinice �. 
Da biste uneli vrednost u nepodrazumeva-
nim mernim jedinicama, morate uneti ispra-
vnu skraćenicu (izdvojeni deo teksta sa leve
strane). Na primer, možete koristiti „pt” ili
„p” za pointe, ali ne i „pts”. Agiti, u slučaju
da se čudite, koriste se za merenje vertikalne
dužine kolone u plaćenim oglasima.

Pajkovi i pointi
Pajk je standardna jedinica mere koja se
koristi u grafičkoj umetnosti. Šest pajkova
je jednako 1 inč; 1 pajku odgovara 12
pointa. Pajkovi i pointi se mogu kombino-
vati u istom polju za unos. Na primer, da
biste naznačili četiri pajka i šest pointa, tre-
balo bi da unesete „4p6”.
Bez obzira na tekuće merne jedinice,
pointi se uvek koriste za merenje veličine
slova, proreda, širine lenjira, debljine
ramova i debljine linija. 

Korišćenje matematike u poljima za
unos
Za sabiranje, unesite + posle tekućeg broja,
a zatim vrednost koju želite da dodate. Za
oduzimanje, unesite -, zatim vrednost koju
želite da oduzmete. Za množenje, unesite
*, zatim vrednost kojom se množi. Za delje-
nje, unesite /, zatim broj kojim se deli. (Da
biste 38 podelili sa 3, na primer, trebalo bi
da uneste „38/2”.) U svakom slučaju pritis-
nite Return/enter da biste izvršili raču-
nanje.

� Unesite broj u
bilo kojim mernim
jedinicama koje se
koriste u programu
QuarkXPress.

5.0!

� Merne jedinice za Default Web Document
(podrazumevani dokument za Web)

� Kada se pritisne Return/Enter,
ova vrednost se pretvara u
trenutno izabrane podrazumevane
merne jedinice.

Skraćenice
Inči in ili "

Decimalni inči in ili " sa decimalnom 
tačkom

Pajkovi p

Pointi pt ili p posle koga sledi 
broj (recimo „p6”)

Milimetri mm

Centimetri cm

Ciceri c

Agiti ag

Četvrtina q
milimetra

Pikseli px

Napomena: Pikseli ne mogu da budu izabrani u
dokumentu za štampanje, ali „px” se može koristiti u
poljima za unos u dokumentu za štampanje.



Poželjne opcije (kraći uvid)
Moguće je izabrati poželjne opcije za poje-
dinačna dokumenta, ili za program kao
celinu, kao njihove podrazumevane para-
metre. Poglavlje 22 je u celosti posvećeno
okvirima za dijalog Preferences, a neka od
ovih podešavanja se razmatraju u pojedi-
nim poglavljima, tamo gde je to bilo potre-
bno. Učeći QuarkXPress, tu i tamo ćete
menjati ove parametre i na taj način poste-
peno postajati bliskiji sa njima. Navešćemo
neke parametre koji mogu da se menjaju.

SAVET Za jednu od alatki okvira za sliku
uključite opciju Runaround i/ili definišite
ram, a za drugu alatku okvira za dijalog
isključite ova podešavanja – na taj način
ćete imati po jednu alatku za obe potrebe.
Promenite vrednost Corner Radius na nulu
ako želite da napravite još jednu
pravougaonu alatku za crtanje okvira.
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Delimični spisak parametara koji mogu da se menjaju:

■ Margine, lenjiri ili boje pomoćnih linija.

■ Rezolucija kojom se pregledaju uvezene
slike.

■ Brzina kretanja kroz dokument.

■ Tipografske opcije.

■ Uključivanje ili isključivanje tehnike kopi-
ranja povlačenjem i puštanjem.

■ Širina pomoćne radne površine.

■ Opcije za automatsko snimanje i auto-
matsko pravljenje rezervne kopije doku-
menta.

■ Automatsko snimanje biblioteka objekata.

■ Opcije prikazivanja pomoćnog progra-
ma XTensions Manager.

■ Merne jedinice za lenjire, okvire za dija-
log i paletu Measurements.

■ Opcije auomatskog umetanja stranica.

■ Način prikazivanja pomoćnih linija.

■ Opcije automatskog umetanja slika.

■ Brisanje ili čuvanje objekata na matič-
noj strani.

■ Uključivanje ili isključivanje osvežavanja
prikaza.

■ Rastojanje između linija pomoćne
mreže.

■ Način rastavljanja reči na slogove.

■ Automatski razmak između parova
slova.

■ Širina promenljive beline. 

■ Opcije za ligature.

■ Beline između i oko tekstova, razmeš-
tanje teksta oko slike, debljine linija itd.

■ Opcije za pasovanje.

■ Vrednosti za alatke, uključujući stil,
debljinu, boju, senku i razmeštanje tek-
sta za alatke za crtanje linija ili putanja
za tekst, boju pozadine, ugao, ram i
razmeštanje teksta za alatke okvira za
tekst ili Bezjeovog okvira za tekst, boju
pozadine, broj kolona, ram i razmeš-
tanje teksta za alatku okvira za tekst i
procenat uvećanja pri svakom pritisku
miša za alatku za promenu veličine
prikaza. 

Ostale prednosti korišćenja
podrazumevanih vrednosti
Ako dodajete, brišete ili menjate stilove
(uključujući i stil Normal), boje, izuzetke pri
prelamanju reči, podešavanja za prelama-
nje reči i poravnavanje teksta ili rečnik za
proveru pravopisa kada ni jedan dokument nije
otvoren, sve što promenite postaće nova
podrazumevana vrednost za sve naredne doku-
mente koje budete izrađivali.

Isto važi i za opciju Document Preferences
kojom menjate podešavanja dokumenta, recimo
merne jedinice, automatsko umetanje strana ili
automatsko umetanje slika, kada nijedan doku-
ment nije otvoren. Ova opcija se bira iz menija
Edit > Preferences. Potrošite neko vreme na
podešavanje podrazumevanih vrednosti za doku-
mente – time ćete kasnije uštedeti silno vreme. 


